EndoStim® is a registered trademark of EndoStim, Inc.

⚠️ Read all accompanying documentation before using the device.

The information contained in this document may be changed without notice.

No part of this document may be reproduced or transmitted in any way or by any means, either electronic or mechanical, for any purpose without the express written consent of EndoStim, Inc.
<table>
<thead>
<tr>
<th>SYMBOL</th>
<th>DESCRIPTION</th>
<th>SYMBOL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>![manufacturer]</td>
<td>Manufacturer</td>
<td>![open_here]</td>
<td>Open Here</td>
</tr>
<tr>
<td>![date_of_manufacture]</td>
<td>Date of Manufacture</td>
<td>![torque_wrench]</td>
<td>Torque Wrench</td>
</tr>
<tr>
<td>![consult_instructions]</td>
<td>Consult instructions for use.</td>
<td>![type_b_applied_part]</td>
<td>Type B Applied Part</td>
</tr>
<tr>
<td>![do_not_use_if_package_is_damaged_or_opened]</td>
<td>Do Not Use if Package is Damaged or Opened</td>
<td>![caution]</td>
<td>Caution</td>
</tr>
<tr>
<td>![transport_temperature_limits]</td>
<td>Transport Temperature Limits</td>
<td>![power_indicator]</td>
<td>Power Indicator</td>
</tr>
<tr>
<td>![sterilized_withethyleneoxide]</td>
<td>Sterilized with Ethylene Oxide</td>
<td>![intentional_radiator]</td>
<td>Intentional Radiator</td>
</tr>
<tr>
<td>![use_by]</td>
<td>Use By</td>
<td>![signal_strength_indicator]</td>
<td>Signal Strength Indicator</td>
</tr>
<tr>
<td>![do_not_reuse]</td>
<td>Do Not Reuse</td>
<td>![usb_connector]</td>
<td>USB Connector</td>
</tr>
<tr>
<td>![do_not_resterilize]</td>
<td>Do not resterilize</td>
<td>![mr Unsafe_programmer]</td>
<td>MR Unsafe (Programmer)</td>
</tr>
<tr>
<td>![part_number]</td>
<td>Part Number</td>
<td>![mr Conditional_ipg_and_lead]</td>
<td>MR Conditional (IPG and Lead)</td>
</tr>
<tr>
<td>![lot_number]</td>
<td>Lot Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>![serial_number]</td>
<td>Serial Number</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Table of Contents

- Explanation of Symbols on Labels ................................................................. 3
- Table of Contents .................................................................................................. 4
- List of Acronyms and Abbreviations ..................................................................... 7
- System Components and Package Contents .......................................................... 7
  - Model 1011 EndoStim LES Stimulator and Lead Package .................................... 7
- Indications for Use .................................................................................................. 8
- Contraindications ................................................................................................... 8
- Special Patient Populations .................................................................................. 8
- Warnings and Precautions ..................................................................................... 8
  - General Precautions .......................................................................................... 10
- Potential Adverse Events ....................................................................................... 12
- EndoStim System Overview .................................................................................. 13
  - Implantable Pulse Generator Description ............................................................ 14
    - X-ray Identification for the IPG ........................................................................ 14
  - Implantable Bipolar Stimulating Lead Description ............................................... 14
  - Programmer System Description ........................................................................ 15
- Implant Procedure for the Lead and IPG ................................................................ 16
  - Recommended Operating Room Equipment for Laparoscopic Procedure .................. 16
  - Pre-Operative Considerations ............................................................................ 16
  - Prepare the EndoStim Programmer System .......................................................... 17
    - Implant the IPG and Lead ................................................................................ 17
      - Prepare the Patient and Laparoscopic Ports ...................................................... 17
      - Prepare the Esophagus .................................................................................... 18
      - Introduce the Lead ........................................................................................ 18
      - Implant the Electrodes ................................................................................... 19
      - Create the Pocket for the IPG ........................................................................ 20
      - Routing the Lead to the Subcutaneous Pocket ............................................... 20
      - Connect the Lead to the IPG .......................................................................... 21
      - Measure Lead Impedance (IPG out of pocket) ............................................... 21
      - Place the IPG in the Subcutaneous Pocket ...................................................... 21
      - Measure Lead Impedance (IPG in pocket) ...................................................... 23
  - Surgical Pocket Closure .................................................................................... 23
- Post-Operative Care .............................................................................................. 23
  - MRI Safety Information ..................................................................................... 23
- Patient ID Card ..................................................................................................... 24
- Explant Procedure .................................................................................................. 24
  - Explanting the IPG Only .................................................................................... 24
    - Pre-Explant Preparation .................................................................................. 24
    - Opening the Pocket and Removing the IPG ...................................................... 25
  - Explanting the IPG and Lead .............................................................................. 25
    - Opening the Pocket and Removing the IPG ...................................................... 25
    - Electrode Explant Procedure .......................................................................... 25
    - Lead Extraction from the Abdominal Cavity .................................................... 25
    - Surgical Pocket Closure ................................................................................... 26
- Post-Operative Care .............................................................................................. 26
List of Acronyms and Abbreviations

<table>
<thead>
<tr>
<th>Acronym/Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMI</td>
<td>Body Mass Index</td>
</tr>
<tr>
<td>CISPR</td>
<td>Comité International Spécial des Perturbations Radioélectriques (Special International Committee on Radio Interference)</td>
</tr>
<tr>
<td>ECG</td>
<td>Electrocardiogram</td>
</tr>
<tr>
<td>EMI</td>
<td>Electromagnetic Interference</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IPG</td>
<td>Implantable Pulse Generator</td>
</tr>
<tr>
<td>ICD</td>
<td>Implantable Cardioverter Defibrillator</td>
</tr>
<tr>
<td>MR</td>
<td>Magnetic Resonance</td>
</tr>
<tr>
<td>MRI</td>
<td>Magnetic Resonance Imaging</td>
</tr>
<tr>
<td>PEL</td>
<td>Phreno-Esophageal Ligament</td>
</tr>
<tr>
<td>RF</td>
<td>Radio Frequency</td>
</tr>
<tr>
<td>T2DM</td>
<td>Type 2 Diabetes Mellitus</td>
</tr>
<tr>
<td>TENS</td>
<td>Transcutaneous Electrical Nerve Stimulation</td>
</tr>
<tr>
<td>DOWN</td>
<td>This IPG mode is entered when the IPG finds an internal fault.</td>
</tr>
</tbody>
</table>

System Components and Package Contents

Model 1003 EndoStim Implantable Bipolar Lead Package
- 1 Implantable Bipolar Stimulating Lead
- 1 Set of peel-off labels

Model 1006 EndoStim LES Stimulator
- 1 Model 1006 EndoStim II Implantable Pulse Generator
- 1 Torque wrench (Allen-type)
- 1 Set peel-off labels for IPG

Model 1011 EndoStim LES Stimulator and Lead Package
- 1 Model 1006 EndoStim II Implantable Pulse Generator
- 1 Model 1003 EndoStim Implantable Bipolar Stimulating Lead
- 1 Torque wrench (Allen-type)
- 1 Set peel-off labels for IPG
- 1 Set of peel-off labels for Lead

Model 1012 EndoStim LES Programmer System
- Model 1504 EndoStim LES Programmer USB Wand
- Model 1522 Tablet PC with EndoStim LES Programmer Software

Accessory
- Model 1550 EndoStim Therapy Suspension Magnet
Indications for Use

The EndoStim® Lower Esophageal Sphincter (LES) Stimulation System is indicated for subjects diagnosed with pathological gastro-esophageal reflux disease (GERD), as defined by abnormal pH, and who continue to have chronic GERD symptoms despite maximum medical therapy for the treatment of reflux or who are “intolerant” to medical therapy with PPI’s. “Intolerance” is defined as those patients who experience severe side effects such as anaphylaxis or a severe allergic reaction, recurrent C. diff, severe hypomagnesaemia to one PPI or experience mild/moderate side effects such as nausea, vomiting, diarrhea or abdominal pain to at least 2 PPIs of different chemical classes.

Contraindications

The EndoStim LES Stimulation System (EndoStim System) is contraindicated for individuals who are pregnant or nursing.

Special Patient Populations

The EndoStim System has not been evaluated in the following populations.

- Severe Grade D esophagitis
- Long segment Barrett’s esophagus or Barrett’s esophagus with dysplasia
- Severe esophageal dysmotility
- Gastroparesis
- Suspected or confirmed esophageal or gastric cancer
- Esophageal or gastric varices
- Dysphagia due to severe esophageal peptic structure
- History of previous esophago-gastric surgery such as laparoscopic fundoplication or an esophageal myotomy
- Large hiatal hernia
- Significant uncontrolled autoimmune disorder
- Severe obesity with a body mass index (BMI) greater than 35 kg/m²
- Type 1 diabetes mellitus
- Uncontrolled Type 2 diabetes mellitus (T2DM) defined as HbA1c > 9.5 in the previous 6 months, or has T2DM for more than 10 years
- Has an existing active implantable medical device
- Significant psychiatric disorder that may interfere with therapy
- Significant cardiac arrhythmia, or ectopy, or significant cardiovascular disease
- Pregnant or nursing.

Warnings and Precautions

Age limitations—The devices in the EndoStim System are indicated for patients between the ages of 22 and 75. Do not implant an EndoStim System in patients less than 22 years old because safety and effectiveness have not been tested in a younger population.

Allergies—There is the possibility of an allergic or immune system response to the implanted materials. (See Specifications Table 1 and Table 3).

Anticoagulation therapy—Patients who are on anticoagulation therapies may be at a greater risk for post-operative complications, such as hematoma formation.
**Bowel obstruction**—The lead can become entangled with or erode into the bowel, which can result in bowel obstruction and perforation. Either may lead to life-threatening intra-abdominal infections and may require laparotomy, bowel resection, and system revision. Avoid excess lead slack in the abdominal cavity. Post-implant, consider lead entanglement or erosion as a possible etiology in patients with bowel obstruction symptoms.

**Component compatibility**—Use only EndoStim components that are compatible with this system. The use of non-EndoStim components with this stimulation system can result in damage to the components, loss of therapy, or patient injury.

**Infection**—Prophylactic intravenous antibiotics may be administered during the implant procedure. When possible, identify and treat any infections remote to the implant site prior to surgery. Infections at the implant site almost always require the surgical removal of the implanted system.

**IPG case damage**—If the IPG case is ruptured or pierced due to outside forces, then severe burns could result from exposure to the battery chemicals.

**Therapeutic magnets**—Therapeutic magnets (e.g., magnetic mattresses, blankets, wrist wraps, elbow wraps, etc.), can inadvertently turn the device OFF for a period of 24 hours. Please advise patients to place therapeutic magnets at least 10 inches (25 cm) away from their IPG. Magnetic fields of less than 10 Gauss will generally not affect the IPG.

**Environmental hazards**—Do not use any other electrical equipment adjacent to the EndoStim System. If the components cannot be kept separate, then monitor devices to assure normal operation. Portable and mobile RF (radio frequency) equipment can interfere with the normal operation of the EndoStim System. The portable and mobile RF equipment should be considered in any situation where the EndoStim System devices are not acting as expected. Other equipment may interfere with these devices, even if that equipment complies with CISPR emission limits.

As with any medical device system, all the components of the EndoStim System can be affected by magnetic, electrical, and electromagnetic signals of sufficient strength. On rare occasions, interfering signals could inhibit electrical stimulation delivery or, alternatively, trigger inappropriate delivery of electrical stimulation signals. In addition, certain sources can couple sufficient energy into the IPG to damage the circuitry of the IPG and/or LES tissue adjacent to the electrodes. The physician may wish to discuss these risks with the patient.

The susceptibility of a particular unit will also depend on the location of the IPG pocket, the nature of the interference, and the programmed operating parameters.

Because of the diversity of potential causes of electromagnetic interference, EndoStim cannot characterize and describe within this manual the effects of all potential sources of interference.

**Warning**: Advise patients to be cautious when in the vicinity of equipment that generates electrical or magnetic fields, and to seek medical advice before entering an area posted with a warning for pacemaker patients (or other medical implantable devices).

**Electrocautery**—Electrocautery can damage the lead or IPG. It can also cause temporary suppression of IPG output and/or reprogram the IPG to other parameter values that require IPG reprogramming. Application of electrocautery close to an IPG can also cause damage to the tissue of the lower esophageal sphincter, possibly producing burns. Electrocautery may also cause induced currents in the lead portion of the EndoStim System that could be hazardous or cause further injury. Follow these precautions when using electrocautery:

- Turn off the IPG before performing electrocautery.
- Do not contact the lead or IPG with the electrocautery device.
- Only bipolar cautery is recommended.
- If it is necessary to use unipolar cautery, then
  - Do not use high voltage modes.
  - Keep the power setting as low as possible.
  - Keep the current path (ground plate) as far away from the IPG and lead as possible.
- Do not use an electrosurgical tip in close proximity (closer than 2 inches or 5 cm) to the IPG or lead.
- Check the IPG for proper operation immediately following the procedure. If the unit is found in the DOWN mode, follow the Reset procedure in Appendix 1.

**RF ablation**—Safety has not been established for radiofrequency (RF) or microwave ablation in patients with an implanted EndoStim System. Induced electrical currents from these procedures to the EndoStim System may cause heating, especially at the lead electrode site, resulting in tissue damage. If RF ablation is necessary,
- Position the ground plate as far from the IPG and lead as possible.
- Avoid direct contact with the ablation catheter and the IPG and lead.
- Program the IPG to the OFF mode for the duration of the ablation procedure to reduce the possibility of adverse effects.
- Check the IPG for proper operation immediately following the procedure. If the unit is found in the DOWN mode, follow the Reset procedure.

**Defibrillation**—Any implanted active medical device can be damaged by cardiac defibrillation procedures. In addition, the defibrillation current can cause damage to LES tissue adjacent to the electrodes and/or to tissue surrounding the IPG. The defibrillation current may also cause the IPG to revert to its DOWN mode, with possible loss of statistics data. If sufficient energy is coupled into the system, the unit may be damaged. If defibrillation is necessary, position the paddles as far away from the implanted system as possible; avoid having the IPG in the defibrillation current path between the paddles. Following defibrillation, closely monitor the performance of the IPG. If an operational abnormality is detected, consider repositioning or replacing the lead and/or reprogramming (or replacing) the IPG. If the IPG changes to the DOWN mode, follow the Reset procedure.

**Therapeutic radiation**—Do not direct high radiation sources such as cobalt 60 or gamma radiation at the EndoStim System. If radiation therapy is required in the vicinity of the EndoStim System, place lead shielding over the device to prevent radiation damage.

**Magnetic Resonance Imaging (MRI)**—EndoStim recommends that patients who are implanted with the EndoStim IPG and/or lead not be exposed to full-body Magnetic Resonance Imaging (MRI). The EndoStim System has not been fully tested for safety or operation after exposure to this environment. The hip, back and abdomen should not be imaged. MRI using 1.5T and 3T equipment using local transmit/receive coils ONLY placed over the head or lower extremities is allowed under the conditions listed in the MRI Safety Information section. The patient should be carefully monitored during exposure to the MR environment and instructed to report any unusual or uncomfortable sensations to medical personnel immediately.

**Lithotripsy**—Direct exposure of the EndoStim IPG to lithotripsy shock waves can cause damage to the IPG. If the implant site is outside of the shock-wave path, no clear contraindication to the use of lithotripsy can be established.

As a precaution, program the IPG to the OFF mode to reduce the possibility of adverse effects. Check the IPG for proper operation immediately following the procedure. If the unit is found in the DOWN mode, follow the Reset procedure.

If lithotripsy must be used, do not focus the beam within 6 inches (15 cm) of the IPG.

**Interaction with other implantable devices**—The EndoStim System may affect the operation of other implanted devices, such as cardiac pacemakers, implantable cardioverter-defibrillators (ICDs), neurostimulation systems, and implantable drug infusion pumps. Physical proximity may cause sensing problems and inappropriate device responses. Clinicians involved with both devices should evaluate any potential interference problems before surgery.

**General Precautions**

**Patient selection**—Select patients carefully to assure that their symptoms are of physiological origin and they are appropriate candidates for surgery.
Patient management—Best results are achieved when the patient is fully informed about the therapy risks and benefits, surgical procedures, follow-up requirements, and self-care responsibilities. Maximum benefits from the EndoStim System require long-term postsurgical management of patients.

Patient activities—Advise patients to avoid activities that may put undue stress on the implanted components of the EndoStim System. Activities that include sudden, excessive, or repetitive bending, twisting, bouncing, or stretching can cause component fracture or dislodgement. Component fracture or dislodgement can result in a cessation of stimulation, intermittent stimulation, stimulation at the fracture site, and additional surgery to replace or reposition a component.

- **Twiddler’s syndrome**—Caution patients to avoid manipulating or rubbing the implanted components of the EndoStim System, which can cause component damage, skin erosion, or stimulation at the implant site.
- **Scuba diving**—Patients should not dive below 7.4 meters (24 feet) of water or enter hyperbaric chambers above 1.5 atmospheres absolute (ATA) or 150 kPa (21.8 pounds per square inch absolute). Pressures below 7.4 meters (24 feet) of water (or above 1.5 ATA) could damage the EndoStim System. Before diving or using a hyperbaric chamber, patients should discuss the effects of high pressure with their doctor.

Component handling—Do not implant a component under the following circumstances:

- When the storage or blister package has been pierced, altered, or damaged in any way
- If the component shows signs of damage
- If the “Use By” date has expired (because this can adversely affect storage package sterility and battery longevity)
- In the case of an IPG and Lead, if it is dropped more than 12 in (30 cm)

Storage temperature—Store the IPG at a temperature range of 20°C (68°F) to 25°C (77°F) and in a dry location. Do not allow the sterile packaging to become damp or wet because sterilization of the contents may be compromised. Exposure to temperatures below 0°C may cause a change in the parameter values of the IPG to the DOWN mode (no output). Once the IPG is removed from the extreme environment, it will either return to the programmed settings, or it will remain in the DOWN mode. In the latter case, follow the Reset procedure. If unsuccessful, the unit should be returned to EndoStim.

Physician training—Implanting physicians must have training in the surgical and/or implantation techniques for the EndoStim System. Physicians using the system must have training on the operational and functional characteristics of the EndoStim System, and experience in the continued management of patients by stimulation parameter adjustment. Physicians using the system should be thoroughly familiar with appropriate supporting material, including, all product labeling and education and training materials.

System implant precautions—Refer to the implant procedure section.

Single Use Only—The IPG and Lead components are intended for single use only. Do not reuse these components.

Resterilization—EndoStim has sterilized the IPG and Lead package contents according to the process indicated on the package labels before shipment. Sterile devices are for single use only and are not intended to be re-sterilized.

Transcutaneous Electrical Stimulator (TENS)—Do not place TENS electrodes so that the TENS current passes over any part of the IPG / lead system. If the patient feels that the TENS unit may be interfering with the IPG, advise the patient to talk with their doctor.

Home appliances—Home and commercial microwave ovens in good condition, and used as intended, will not affect the EndoStim IPG. Even a defective oven that exposes the IPG to direct microwave energy may not damage the unit itself. Ovens using electromagnetic induction can cause the device to go into magnet mode (disable stimulation therapy output).

Inform patients about the possibility of interference from some electric razors, electric power tools and electrical ignition systems, including those used on gasoline-powered devices. In general, patients who have an IPG may operate gasoline-powered devices if protective hoods, shrouds, and other shielding remain in place.
Anti-theft systems/Security screening devices—Advise patients to use care when approaching theft detectors and security screening devices (such as those found in airports, libraries, and some department stores) as these devices may cause temporary interference or permanently reset the device. Instruct patients that when approaching these devices, including full body scanning devices, to do the following:

- If possible, request to bypass these devices. The patient should show the security personnel their patient identification card for the EndoStim System and request a manual search. Security personnel may use a handheld security wand but the patient should ask the security personnel not to hold the security wand near the IPG any longer than is absolutely necessary. The patient may want to ask for another form of personal search.
- If patients must pass through the theft detector or security screening device, they should approach the center of the device and walk through normally.
- Do not linger near, or lean on, the screening device.

Industrial machinery—Advise patients to exercise care or avoid the following equipment or environments:

- Antenna of citizen band (CB) radio or ham radio
- Electric arc welding equipment
- Resistance welders
- Electric induction heaters used in industry to bend plastic
- Electric steel furnaces
- High voltage (safe if outside the fenced area)
- Television and radio transmitting towers (safe if outside the fenced area)
- Microwave communication transmitters (safe if outside the fenced area)
- Linear power amplifiers
- High power amateur transmitters
- Perfusion systems
- Magnets or other equipment that generate strong magnetic fields
- Magnetic degaussers

Portable devices—Cellular and wifi-enabled devices can interfere with the operation of the EndoStim System. Potential effects may result from either the radio frequency emitted by these devices or the magnet within the device speakers. These effects may include inhibition or inappropriate triggering of electrical stimulation delivery when the phone is in close proximity (within 25 cm) to the IPG or lead.

Advise patients to hold cellular phones to the ear opposite the side of the implanted IPG. Patients should not carry the cellular phone in a breast pocket or on a belt over or within 25 cm of the implanted IPG because some cellular phones emit signals when they are turned on though not in use.

Disposal of explanted product—Return all explanted components to EndoStim for analysis and safe disposal. Do not autoclave an explanted IPG or lead before returning the product. Doing so may damage the device and electronics, making it more difficult to analyze the product.

Potential Adverse Events

Potential adverse effects/events associated with the implantation of the EndoStim IPG and lead include, but are not limited to, the following: unstable blood pressure, vertigo, hemATOMA, seroma, injury to organs, blood vessels or other structures, internal bleeding, bleeding from the incisions, blood clot, nerve damage, tissue perforation, abrasion or erosion, injury to organs within the abdominal cavity, wound separation, intravenous site complications, partial or complete blockage of the bowel, inflammation, infection, fever, adhesions, pneumonia, cardiac arrhythmia, cardiopulmonary depression, incisinal hernia, sleep problems (insomnia), excess salivation, hiccups, dysphasia,
bloating, belching, dyspepsia, early satiety/eating less, worsening pre-existing psychiatric illness, pain or discomfort and death.

Additional adverse effects that could be associated with the EndoStim System include, but are not limited to, the following: lead/electrode dislodgement; lead erosion or perforation into the esophagus, stomach, or intestine; IPG migration in the subcutaneous space; IPG erosion through the skin; diaphragmatic stimulation; stimulation of abdominal muscle; irritation, pain, and/or inflammatory response to the IPG and/or the lead; allergic reaction to materials; worsening of GERD symptoms or objective measures; irritable bowel syndrome or dyspepsia; flatulence; nausea; excess salivation; bloating; belching; inability to belch or vomit; food impaction; regurgitation of food or mucus or vomiting; globus sensation; early satiety, eating less, or weight loss; dysphagia; odynophagia; hematoma; infection; cardiac arrhythmia; worsening pre-existing psychiatric illness; and discomfort. LES stimulation ceases when the battery in the IPG is completely discharged.

There is a potential that any system component could malfunction (e.g., software bug), become damaged (e.g., lead fracture), or the patient’s incision could become infected. System component malfunction or other clinical circumstances (e.g., sepsis) may require noninvasive corrective actions or possibly even a surgical revision (repositioning, replacement, or removal) of the malfunctioning component(s). Over time, there is a potential for loss of therapeutic effect, even if the system is functioning properly.

It is recommended to shut the system down if the patient experiences severe sensation, uncomfortable muscle stimulation, or diaphragm stimulation.

Potential adverse events and risks associated with a typical laparoscopic procedure are included in the clinical investigational plan.

Notes:

To eliminate any sensation, discomfort, or pain that may be related to stimulation, use the Programmer to complete the following parameter adjustments:

- Switch polarity and/or
- Reduce stimulation amplitude incrementally in steps of 0.5 mA, until the adverse effect resolves.

If such attempts are not successful, it may be necessary to shut down the system.

A dramatic increase of the lead impedance, which may be followed by a stable impedance period, may indicate a partial or complete lead dislodgement. Patient symptoms should be monitored and, if deteriorating, x-ray or fluoroscopy is recommended to assess the lead and electrode locations.

EndoStim System Overview

The EndoStim LES Stimulation System consists of three components: an implantable pulse generator (IPG), an implantable bipolar simulating lead, and an external programmer system (Figure 1).
Implantable Pulse Generator Description

The EndoStim implantable pulse generator (IPG), is an internally powered (lithium battery) device that delivers electrical stimulation pulses to the lower esophageal sphincter (LES). The IPG is hermetically sealed in a titanium case (Figure 2). It delivers electrical pulses to the LES via a bipolar IS-1 BI header connector port that connects the IPG and lead. The IPG is sterilized with ethylene oxide and is a single-use only device. The programmable IPG communicates with the external Programmer System via telemetry.

X-ray Identification for the IPG

A radiopaque marker placed within the IPG allows the model number and year of manufacture to be identified by normal X-ray techniques. The manufacturer’s identification code for EndoStim is E, the code for the EndoStim IPG Model 1006 is B and the code for the year of manufacture is XX, where XX is replaced by the last two digits of the calendar year in which the device was manufactured.

Implantable Bipolar Stimulating Lead Description

The EndoStim lead, called the Implantable Bipolar Stimulating Lead, is used in conjunction with the IPG (Figure 4). An IS-1-BI connector¹ at the proximal end of the lead attaches it to the IPG. The lead delivers stimulation pulses to the tissue through stitch electrodes at the distal end. During the implant procedure, stitch electrodes on the leads are sutured into the lower esophagus and secured into place (Figure 5). The lead is sterilized with ethylene oxide and is a single-use only device.

Programmer System Description

The EndoStim Programmer System has two components: programmer software and a hand-held wand that contains communications electronics (Figure 6). The Programmer software runs on an IEC60950 certified Tablet PC supplied by EndoStim, which runs on battery power only when in use. The Programmer Wand connects to the USB port of the computer.

Use the EndoStim Programmer System to communicate wirelessly with the IPG by placing the Programmer Wand on the subject’s clothing directly over the IPG implant site. Use the Programmer to:

- Read (interrogate) IPG parameters as currently programmed
- Modify IPG parameters
- Retrieve statistics accumulated by the IPG as it operates
- Log the activity of the IPG programming session
- Generate reports that can be printed from another computer

Place the Tablet PC at least 1.5 meters from the patient. The Tablet PC must be run on battery power only. Refer to Appendix 1 for programmer use instructions and maintenance.
Implant Procedure for the Lead and IPG

The EndoStim LES Stimulation System implant is performed while the patient is under general anesthesia using sterile technique. EndoStim recommends discussing the use of anesthesia and antibiotics with the patient prior to surgery.

EndoStim recommends that prophylactic antibiotic coverage be administered within 60 minutes before the first skin incision. If the procedure lasts longer than 2 hours, administer a second prophylactic antibiotic.

EndoStim recommends standard sterile septic techniques during insertion and withdrawal of the cannula.

Recommended Operating Room Equipment for Laparoscopic Procedure

At a minimum, to perform the laparoscopic procedure, have the following sterile instruments ready:

- Laparoscopic tower (30°/0° optical probe)
- Endoscopic equipment
- Needle holder (laparoscopic)
- Laparoscopic graspers and dissectors
- Laparoscopic scissors
- Harmonic scalpel (recommended)
- Coagulation hook (optional)
- Liver retractor (a fixed type retractor e.g. Nathanson is recommended)
- 10/12 mm laparoscopic port (1)
- 5 mm laparoscopic ports (3-4)
- Clip application tool: (a 10 mm multi-use reloadable device is recommended)
- 3-0 Ethibond Excel (or any other non-resorbable multi-filament) with a tapered round bodied, short needle for suturing the electrode butterflies, and 0-Ethibond for suture of the crura (if needed)
- Basic surgical instrument kit for the creation of the subcutaneous pocket

A video recording system is also recommended.

Pre-Operative Considerations

Determine the surgical site for implanting the IPG. Discuss the position with the patient so they are comfortable with the location of the device and surgical scar with regard to sleeping, posture, and exposure. It is recommended to make a horizontal incision of 4.0 cm at the level of the upper edge of the umbilicus (Figure 7). Mark the surgical area before scrubbing and prepping the patient for the procedure.
Prepare the EndoStim Programmer System

Before the surgical procedure, make sure the Tablet PC is fully charged by plugging the power supply into a nearby outlet (at least 4 hours are required for full charging), arrange the Tablet PC and EndoStim USB Programmer Wand on a portable table. Prior to using the programmer, disconnect the power supply from the Tablet PC and connect the programmer wand to the USB port. Power on the Tablet PC and log in (password is “EndoStim”), verify date and time using the “tools” menu and selecting “System Time”.

It is recommended that you recharge the tablet immediately after every use.

Implant the IPG and Lead

Note: Always have a backup lead and IPG in the OR before starting an implant procedure.

Prepare the Patient and Laparoscopic Ports

1. Prep and drape the patient as appropriate for a laparoscopic procedure.

2. Position 4 - 5 laparoscopic ports as shown in Figure 8 (or use a working position that is appropriate). This plan is based on the surgeon working in the lateral right position. If the surgeon prefers to work in the French position, ports should be as for any other laparoscopic lower esophageal intervention. The suggested port positions include:
   - One port for optics and insufflation
   - One port for the liver retractor
   - Two working ports
   - One assistant port
   - One of the ports should be a 10mm one to accommodate the 10 mm clips applier

The assistant port may be placed along the IPG incision line, preferably at its left lateral angle. Place the table in a reverse Trendelenburg position.
Prepare the Esophagus

1. Retract the liver to completely expose the entire length of the abdominal esophagus. Retract the stomach close to the cardia.

2. For Endostim electrode implantation, a rectangular area of 3 cm by 2 cm on the frontal right aspect of the lower esophagus should be prepared (Figure 11). The anterior vagal branch should be preserved.

3. Gain access to the right side of the hiatus through the Pars Flaccida. By blunt dissection and harmonic scalpel use, expose the muscle surface of the anterior and right aspects of the lower esophagus. Dissect the fat pad and underlying ligaments to expose the esophageal muscle (dissection of the adventitia is not needed). It is recommended to use a harmonic scalpel, although it is acceptable to carefully use a cautery hook.

4. In case the abdominal segment is shorter than 3 cm, but no relevant looseness is observed, consider dissecting the anterior phreno-esophageal ligament (PEL). Such dissection may improve the available length for electrode placement (Figure 9).

5. Prepare a rectangular area, 3 cm by 2 cm, on the frontal right aspect of the lower esophagus (Figure 10).

Introduce the Lead
1. The lead is packaged in a double blister pack. Open the outer blister near the sterile field and have a sterile operator grasp the internal blister pack.

2. After removing the lead from the internal blister, remove both silicone protecting covers from the attached suture needles.

3. Introduce the lead through one of the working ports into the abdominal cavity.

4. Use fingers to advance the lead (connector first) inside the port. Once the connector reaches the abdominal cavity, gently use a grasper from the abdominal side to hold the thick reinforced sections of the cable in order to fully pull the lead into the abdominal cavity.

5. Place the lead on the left lower omentum to free the implantation field from unnecessary lead loops.

   **Note:** Take care to avoid damage to the lead body and electrodes by the laparoscopic instruments. Gently grasp the lead at all times. Avoid grasping the exposed electrodes (the metal segment just ahead of the silicone butterfly). Avoid aggressive grasping and lead kinking.

**Implant the Electrodes**

1. Grasp the needle of the black-dotted electrode close to its base (near the nylon thread); insert the needle close to the esophageal midline with bite exit below diaphragm (Figure 11). Perform a long superficial bite to ensure maximum electrode coverage.

2. Pull and flip the needle backwards as it comes out from the esophageal wall; avoid injury to the diaphragm or liver. Pull the nylon suture applying short cranial strokes or slide it over your other hand’s instrument until the silicone butterfly fully contacts the esophageal wall adjacent to the point of electrode insertion into the muscle.

![Figure 11 Implant Electrode](image)

3. Implant the non-dotted electrode just below the first one with tendency to the right esophageal wall; allow a few millimeters of longitudinal overlap between the electrodes. Consider a lateral distance of 10 ± 2 mm between the electrodes (Figure 11).

4. Fully position the lower electrode using the technique described in step 2 above.

5. Perform an endoscopic check before final fixation to ensure that there is no full thickness penetration of either of the electrodes.

   If penetration has occurred, the electrode would need to be withdrawn and re-inserted.
6. Apply 2 titanium clips to the nylon suture at the exit point from the esophageal muscle, ensuring that the clip is not closing over an exposed electrode segment. Cut the nylon suture as close as possible to the needle, leaving a minimum length of 3 cm of nylon suture.

7. Remove the suture needles from the abdominal cavity.

8. Affix the silicone butterfly anchor to the esophageal muscle wall using sutures (3-0 Ethibond or other non-resorbable, multi-filament threads). Using the shortest needle available, apply a stitch to both sides of the butterfly anchor. It is recommended to take the bites behind (caudal) the butterfly holes to ensure proper flat final position of the butterflies.

9. Suturing may be performed as required to approximate the crura (Figure 12).

10. Inspect the liver and other organs near the electrodes for any potential injuries.

11. Close or cauterize all bleeding vessels to obtain complete hemostasis.

Create the Pocket for the IPG

1. Desufflate the abdomen before making an incision for the IPG pocket.

2. Make the incision along the skin mark drawn earlier (Figure 7).

3. Gain access to the fascia and then use finger(s) to create a subcutaneous pocket appropriate for the size of the IPG. The pocket size should be slightly larger than the IPG size.

   Note: The maximum allowed depth is 3 cm. In case the subcutaneous fat is thicker than 3 cm, the IPG would need to be placed inside the fat and an anchor stitch to the underlying fascia should be used.

4. Re-insufflate the abdominal cavity

Routing the Lead to the Subcutaneous Pocket

1. Use a 5 mm port to puncture the fascia at the upper lateral end of the incision to pull out the lead connector.

2. At the lateral end of the skin incision, push the upper lip of the incision with the tip of the port 1-2 cm towards the rib cage and puncture the fascia (Figure 13). Do this above the lateral upper angle of the pocket.
3. Insert a grasper, grasp the metal end of the lead connector, align it with the grasper axis and pull out. It might be necessary to pull the port together with the grasper.

Connect the Lead to the IPG

1. Clean body fluids and tissue residues from the lead by wiping the lead connector with saline and then dry gauze just prior to connecting to the IPG.
2. After removing the IPG from the inner sterile blister, and prior to inserting the lead connector pin, inspect the bipolar connector terminal (cavity) to ensure that no setscrew is protruding into each cavity.
3. Use the torque wrench (screwdriver) to back off any setscrew found to be protruding beyond the wall of the header cavity by turning it counter-clockwise.
4. Turn the setscrew only enough to pull its tip back out of the header cavity. Do not back the setscrew completely out of the terminal block. Leave the wrench in the septum until the lead is secure. This allows a pathway for venting trapped air when the lead is inserted.
5. Firmly push the connector into the cavity. Inspect the lead to ensure that the tip of the connector protrudes beyond the inner setscrew. To prevent any damage to the setscrew heads, make sure that the screwdriver tip is well inserted in the setscrew hexagonal cavity before tightening it.
6. Turn the screwdriver clockwise until three audible clicks are heard; this ensures proper tightening torque. The lead connector is now plugged into the IPG, but the IPG is still not in the subcutaneous pocket.

Measure Lead Impedance (IPG out of pocket)

See Appendix 1 for instructions.

Place the IPG in the Subcutaneous Pocket

1. Place the IPG into the subcutaneous pocket using a delicate rotational maneuver (Figure 14). Ensure that the EndoStim logo faces up. Once the IPG is partially inserted inside the pocket use a delicate clockwise rotational maneuver to bring it to its final horizontal position (Figure 15).
2. While placing the IPG into the subcutaneous pocket, any lead excess should be pulled inside the abdominal cavity by gentle grasping.

Intra-abdominal lead routing

1. Place the lead excess at the left abdominal side, retract the omental fat and small bowel (as needed) and place the lead body as deep as possible inside the groove formed along the left abdominal wall. The upper part of the lead should pass in front of the spleen or around it depending on the patient’s dimensions. This should minimize any portion of the lead crossing bowel loops, keeping it away from the midline to facilitate future surgical procedures.

2. Ensure that any curve taken by the lead is gentle. This should reduce the chance for kinks and premature failure (Figure 15).

Note: Pay special attention to lead body routing in female patients who are of childbearing age. To reduce the chances of lead erosions into abdominal organs or electrode dislodgements due to increased abdominal pressure and organ displacement that occurs during gestation, do the following: Route the lead body along the groove formed between the left abdominal wall and the intestinal pack, then slightly covering it with the omental fat. Gently turn the lead as high as possible just below or around the spleen, if possible. This routing places the lead body at the periphery of the abdominal cavity, minimizing the direct effect of higher pressure on the lead position.

3. Before removing the port, check that no inadvertent injury to tissue/organs has occurred and that all active bleeding has been addressed.
Measure Lead Impedance (IPG in pocket)
See Appendix 1 for instructions.

Surgical Pocket Closure

1. Withdraw the ports and close the puncture lesions.
2. Carefully suture the subcutaneous layer above the IPG before suturing the skin. An intra-dermal skin closure is recommended for aesthetic reasons.
3. It is recommended to apply antibiotic ointment over the sutures and cover with a sterile dressing.

Post-Operative Care

Monitor the patient with an electrocardiogram (ECG). Monitoring should be done for at least one hour. Suggested monitoring time is approximately 5 minutes at baseline, 30 minutes with stimulation ON, and 25 minutes with stimulation OFF.

Instruct the patient to wear a compression binder over the pocket for at least 30 days post-operatively. This will reduce the chances for fluid accumulation and the possible formation of seroma. Nauseous patients and especially those who had crural approximation should be prescribed anti-emetic medications for a few days post-operatively in order to prevent retching and vomiting which could lead to electrode dislodgement. Provide instructions for standard post-operative treatment and follow up appointments.

Note: To temporarily disable stimulation therapy, apply the Model 1550 Magnet directly over the IPG for at least 2 consecutive seconds as shown in the Figure 16, then remove. This will terminate therapy for 24 hours. Once this 24-hour magnet mode starts, reapplication of a magnet will have no effect (i.e., the 24-hour clock does not restart).

![Figure 16 Correct Placement (perpendicular) and Incorrect Placement (flat) of the Magnet](image)

See Appendix 1 for instructions regarding device-related follow-up activities.

MRI Safety Information

Non-clinical testing has demonstrated the EndoStim LES IPG and lead system is MR Conditional. A patient with this device system can be safely scanned in an MR system meeting the following conditions:
• Static magnetic field of 1.5 T and 3 T using a LOCAL TRANSMIT/RECEIVE COIL ONLY
  o Head and lower extremity scanning only. – The entire EndoStim II LES System must be completely placed away from any local transmit/receive coils.
• Maximum spatial field gradient of 2000 gauss/cm (20 T/m)
• Maximum MR system reported, Head averaged specific absorption rate (SAR) of 3.2 W/kg
• Maximum magnetic gradient slew rate of 200 T/m/s per axis

Prior to the procedure, the IPG should be interrogated and programmed to OFF. (See Appendix 1.) If out of range impedance is discovered during programming, the procedure may not be performed. The patient should be carefully monitored during exposure to the MR environment and instructed to report any unusual or uncomfortable sensations to medical personnel immediately. After scanning has been completed, the IPG should be interrogated, programmed to ON, and set to the previous device settings. (See Appendix 1.) If any error conditions are discovered, please contact EndoStim.

Under the scan conditions defined above, the EndoStim lead is expected to produce a maximum temperature rise of less than 1°C after 15 minutes of continuous scanning.

Patient ID Card
Complete and provide the patient with the patient ID card provided.

Explant Procedure
The patient, physician, and surgeon should use judgment to determine the reasons and necessity for a system explant. In some cases, simply turning off therapy may be a prudent course of action. If an explant is desired and/or needed, the patient, physician, and surgeon should use judgment to determine the necessity of explanting the lead.

Explanting the IPG Only
Pre-Explant Preparation
An EndoStim IPG explant is performed under local or general anesthesia and under sterile conditions. An antibiotic prophylactic coverage should be administered prior to procedure.

Opening the Pocket and Removing the IPG

1. It is recommended to cut around the existing scar to gain access to the IPG.
2. Gently remove the IPG from its fibrous capsule, with the lead still connected.
3. Use the torque wrench (screwdriver) to back off the two setscrews by turning each of them counter-clockwise for at least one rotation.
4. Gently pull the lead from the IPG header cavity.
5. Cover the connector with a silicone cap and secure to the fascia.
6. It is recommended to flush the pocket with a disinfectant/antibiotic solution before suturing the incision.
7. Suture the subcutaneous tissue and skin.

Explanting the IPG and Lead

Use the same surgical equipment and pre-operative considerations as described in the Implant Procedure for the Lead and IPG section. In addition to the optics and insufflation port, use three additional ports, two working ports and one for the liver retractor. An assistant port may be also required.

Opening the Pocket and Removing the IPG

1. It is recommended to cut around the existing scar to gain access to the IPG.
2. Gently remove the IPG from its fibrous pocket, with the lead still connected.
3. Use the torque wrench (screwdriver) to back off the two setscrews by turning each of them counter-clockwise for at least one rotation.
4. Gently pull the lead from the IPG header cavity.
5. If the set screws do not loosen or if there is a significant fibrotic reaction preventing access to the set screws, the lead can be cut.

Electrode Explant Procedure

1. Retract the liver.
2. Take down any adhesions between the implantation site and the liver.
3. Cut through the fibrous tissue capsule that covers the silicone butterflies.
4. Cut off the two proximal sutures of the silicone anchor. Cut the nylon suture distally just below the 2 titanium clips to allow for reverse pull of the electrode from the esophagus.
5. If there is significant fibrosis around the silicone anchors and/or the titanium clips, consider leaving the electrode(s) in place. It is acceptable to cut the lead in pieces to avoid significant surgical effort.

Lead Extraction from the Abdominal Cavity

1. Pull the lead (or lead segments) out through one of the working ports.
2. If there is significant fibrosis inside the abdominal cavity, the surgeon should use judgment on how to extract the lead. It is acceptable to cut the lead in pieces to avoid significant surgical effort.

3. If possible, the titanium clips should be removed as well.

Surgical Pocket Closure
1. Carefully suture the subcutaneous layer above the IPG before suturing the skin.
2. Withdraw the ports and suture the puncture lesions.
3. It is recommended to apply antibiotic ointment over the sutures and cover with a sterile dressing.

Post-Operative Care
Instruct the patient to wear a compression binder over the pocket for at least 30 days post operatively. This will reduce the chances for fluid accumulation and the possible formation of seroma. Provide instructions for standard post-operative treatment and follow up appointments.

Explanted Device Handling
The explanted parts should be flushed and placed in a bio-hazard bag (EXAK-PAK™ or comparable). Follow these guidelines for proper component disposal:
- Do not incinerate the IPG because it can explode if subjected to cremation or incineration temperatures.
- Return all explanted components to EndoStim for analysis and safe disposal.
- Do not autoclave an explanted IPG or lead prior to returning to EndoStim.

Device Specifications
This section contains specifications and characteristics for EndoStim System components.

IPG Specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>62.0 mm</td>
</tr>
<tr>
<td>Width</td>
<td>39.0 mm</td>
</tr>
<tr>
<td>Thickness</td>
<td>8.4 mm</td>
</tr>
<tr>
<td>Volume</td>
<td>17 cc</td>
</tr>
<tr>
<td>Mass</td>
<td>28 g</td>
</tr>
<tr>
<td>Biocompatible materials in contact with human tissue</td>
<td>Titanium</td>
</tr>
<tr>
<td></td>
<td>Epoxy resin</td>
</tr>
<tr>
<td></td>
<td>Silicone rubber set plugs</td>
</tr>
<tr>
<td>Power source</td>
<td>Lithium carbon monofluoride battery</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>20°C (68°F) to 25°C (77°F)</td>
</tr>
</tbody>
</table>
**IPG Battery Characteristics and Specifications**

The battery voltage at beginning of life is approximately 3.1V and the usable capacity is 1.5 Ah. When battery voltage falls below 2.5V, the device sends information to the Programmer, upon interrogation, that the battery is near the end of life. In addition, stimulation amplitude may be reduced if programmed at higher currents. When battery voltage falls below 2.3V, the device will turn off all stimulation outputs. When the battery voltage falls below 2.1V, communication with the Programmer will no longer be possible.

The longevity of the battery can be estimated based on the different stimulating parameters applied, as described in Table 2.

**Table 2. Estimated IPG Battery Longevity**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Condition 1</th>
<th>Condition 2</th>
<th>Condition 3</th>
<th>Condition 4</th>
<th>Condition 5&lt;sup&gt;d&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Width&lt;sup&gt;a&lt;/sup&gt;</td>
<td>215 µsec</td>
<td>215 µsec</td>
<td>215 µsec</td>
<td>215 µsec</td>
<td>215 µsec</td>
</tr>
<tr>
<td>Pulse Frequency&lt;sup&gt;a&lt;/sup&gt;</td>
<td>20 Hz</td>
<td>20 Hz</td>
<td>20 Hz</td>
<td>20 Hz</td>
<td>20 Hz</td>
</tr>
<tr>
<td>Pulse Amplitude&lt;sup&gt;b&lt;/sup&gt;</td>
<td>5mA</td>
<td>5mA</td>
<td>7mA</td>
<td>7mA</td>
<td>10mA</td>
</tr>
<tr>
<td>Hours per Day</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>24</td>
</tr>
<tr>
<td>Lead Impedance</td>
<td>400Ω</td>
<td>400Ω</td>
<td>400Ω</td>
<td>800Ω</td>
<td>800Ω</td>
</tr>
<tr>
<td>Estimated Life&lt;sup&gt;c&lt;/sup&gt;</td>
<td>7.8 years</td>
<td>6.6 years</td>
<td>5.3 years</td>
<td>4.7 years</td>
<td>1.0 years</td>
</tr>
</tbody>
</table>

<sup>a</sup> This is the recommended value
<sup>b</sup> Recommended to never exceed 10 mA (Lead Impedance)
<sup>c</sup> This assumes a 12 month shelf life prior to implant
<sup>d</sup> Recommended to never program continuous stimulation (24 hours) outside the clinic environment

**Lead Specifications**

**Table 3. Lead Physical Description and Materials**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>IS-1 BI</td>
</tr>
<tr>
<td>Mass</td>
<td>~4 g</td>
</tr>
<tr>
<td>Total Lead Length</td>
<td>45 cm from IS-1-B1 connector to end of electrodes</td>
</tr>
<tr>
<td>Bipolar Segment Length</td>
<td>35 cm</td>
</tr>
<tr>
<td>Monopolar Segment Length</td>
<td>10 cm (both)</td>
</tr>
<tr>
<td>Electrode Length</td>
<td>10 mm</td>
</tr>
<tr>
<td>Suture Length</td>
<td>5.5 cm</td>
</tr>
<tr>
<td>Suture Needle</td>
<td>Ski 19 mm, stainless steel</td>
</tr>
<tr>
<td>Electrodes</td>
<td>Platinum-iridium</td>
</tr>
<tr>
<td>Conductors</td>
<td>Cobalt/nickel (MP35N)</td>
</tr>
<tr>
<td>Sheathing</td>
<td>Silicone rubber</td>
</tr>
<tr>
<td>Suture</td>
<td>Nylon</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>20°C (68°F) to 25°C (77°F)</td>
</tr>
</tbody>
</table>

**Programmer Specifications**

The Programmer is an internally-powered, Type B equipment that is designed for continuous use. The Programmer Wand is considered an applied part.

**Table 4. Programmer Specifications**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>140 mm</td>
</tr>
<tr>
<td>Width</td>
<td>62.7 mm</td>
</tr>
<tr>
<td>Thickness</td>
<td>30.5 mm</td>
</tr>
</tbody>
</table>
Mass | 251 g
---|---
Storage temperature | 5°C (41°F) to 37°C (99°F)

**Electromagnetic Emissions**

Guidance and manufacturer’s declaration – electromagnetic emissions

The EndoStim IPG and Programmer are intended for use in the electromagnetic environment specified in Table 5. The customer or user of the EndoStim IPG and Programmer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions Test</th>
<th>Compliance</th>
<th>Electromagnetic Environment - Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions</td>
<td>Group 1</td>
<td>The EndoStim IPG and Programmer use RF energy only for its internal function. Therefore, their RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF emissions</td>
<td>Class A</td>
<td></td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harmonic Emissions</td>
<td>Not Applicable</td>
<td>The EndoStim IPG and Programmer are suitable for use in all establishments other than domestic establishments and those directly connected to the public low-voltage supply network that supply buildings used for domestic purposes.</td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage Fluctuations/Flicker Emissions</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ESD and Power Fluctuations**

Guidance and manufacturer’s declaration – electromagnetic immunity

The EndoStim Programmer is intended for use in the electromagnetic environment specified in Table 6. The customer or user of the EndoStim Programmer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Electromagnetic Environment - Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact ±8 kV air</td>
<td>±6 kV contact ±8 kV air</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Mains power should only be used to recharge the tablet battery while the unit is powered off.</td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Mains power should only be used to recharge the tablet battery while the unit is powered off.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td></td>
</tr>
</tbody>
</table>
### Radiated Electromagnetic Fields

Guidance and manufacturer’s declaration – electromagnetic immunity

The EndoStim Programmer is intended for use in the radiated electromagnetic fields specified in Table 7. The customer or user of the EndoStim Programmer should assure that it is used in such an environment.

Portable and mobile RF communications equipment should be used no closer to any part of the EndoStim Programmer, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.

### Table 7. Radiated Electromagnetic Fields: Electromagnetic Immunity

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Recommended Separation Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF, IEC 61000-4-6, 150 kHz to 80 MHz outside ISM bands</td>
<td>3 Vrms</td>
<td>3 Vrms</td>
<td>$d = 1.17\sqrt{P}$</td>
</tr>
<tr>
<td>Conducted RF, IEC 61000-4-6, 150 kHz to 80 MHz inside ISM bands</td>
<td>3 Vrms</td>
<td>3 Vrms</td>
<td>$d = 1.20\sqrt{P}$</td>
</tr>
<tr>
<td>Radiated RF, IEC 61000-4-3, 80 MHz to 800 MHz</td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>$d = 1.20\sqrt{P}$</td>
</tr>
<tr>
<td>Radiated RF, IEC 61000-4-3, 800 MHz to 2.5 GHz</td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>$d = 2.30\sqrt{P}$</td>
</tr>
</tbody>
</table>

**Notes:**

P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer, and d is the recommended separation distance in meters (m).

Field strengths from fixed radio frequency (RF) transmitter, as determined by an electromagnetic site survey\(^a\), should be less than the compliance level in each frequency range.\(^b\)

Interference may occur in the vicinity of equipment marked with the ionizing radiation symbol:

![Ionizing Radiation Symbol](image)

At 80 MHz and 800 MHz, the higher frequency range applies.

These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the EndoStim Programmer is used exceeds the applicable RF compliance level above, the EndoStim Programmer should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as relocating the EndoStim Programmer.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

**Recommended Separation Distances**

This section discusses the recommended separation distances between portable and mobile RF communications equipment and the EndoStim Programmer. The EndoStim Programmer is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled (Table 8). The customer or user of the EndoStim Programmer can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the EndoStim Programmer as recommended (according to the maximum output power of the communications equipment).

<table>
<thead>
<tr>
<th>Rated Maximum Output Power of Transmitter (W)</th>
<th>Separation Distance According to Frequency of Transmitter</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 kHz to 80 MHz</td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td>800 MHz to 2.5 GHz</td>
</tr>
<tr>
<td>d = 117√P</td>
<td>d = 0.35√P</td>
</tr>
<tr>
<td>d = 0.70√P</td>
<td></td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.37</td>
</tr>
<tr>
<td>1</td>
<td>1.17</td>
</tr>
<tr>
<td>10</td>
<td>3.7</td>
</tr>
<tr>
<td>100</td>
<td>11.7</td>
</tr>
<tr>
<td>0.07</td>
<td>0.44</td>
</tr>
<tr>
<td>0.22</td>
<td>0.35</td>
</tr>
<tr>
<td>0.7</td>
<td>2.22</td>
</tr>
<tr>
<td>7.0</td>
<td>3.5</td>
</tr>
</tbody>
</table>

Notes:

For transmitters rated at a maximum output power not listed above, the recommended separation distance (d) in meters (m) can be estimated by using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

At 80 MHz and 800 MHz, the higher frequency range applies.

These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects, and people.

**Range and Tolerance of Displayed Values**

Table 9 lists IPG and lead parameters with associated range, increment and tolerance values. Device parameters used in this study will be listed in the clinical investigational plan.

<table>
<thead>
<tr>
<th>IPG and Lead Parameters</th>
<th>Range</th>
<th>Increment</th>
<th>Tolerance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial</td>
<td>0001 to 9999</td>
<td>1</td>
<td>N/A</td>
</tr>
<tr>
<td>Battery</td>
<td>2.10 to 3.10 (V)</td>
<td>0.01 V</td>
<td>0.05 V</td>
</tr>
<tr>
<td>Impedance</td>
<td>100 to 5000 (Ω)</td>
<td>1 Ω</td>
<td>Max of 100Ω and 20%</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Range</strong></td>
<td><strong>Increment</strong></td>
<td><strong>Tolerance</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><strong>Stimulation Parameters</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse Width</td>
<td>30 to 975 (µsec)</td>
<td>30 µsec</td>
<td>Max of 5% and 15 µsec</td>
</tr>
<tr>
<td>Pulse Amplitude</td>
<td>2.0 to 10.0 (mA)</td>
<td>0.5 mA</td>
<td>Max of 0.5mA and 20%</td>
</tr>
<tr>
<td>Pulse Rate</td>
<td>2 to 80 (Hz)</td>
<td>2-10 Hz: 1 Hz</td>
<td>10-40 Hz: 2 Hz 40-80 Hz: 5 Hz</td>
</tr>
<tr>
<td>Active Time</td>
<td>00:00:01 to 23:59:59</td>
<td>1 sec</td>
<td>2 sec</td>
</tr>
<tr>
<td>Inactive Time</td>
<td>00:00:01 to 23:59:59</td>
<td>1 sec</td>
<td>2 sec</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>1 to 99 (%)</td>
<td>1%</td>
<td>1%</td>
</tr>
<tr>
<td><strong>Dose Mode Parameters</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dose Time (Duration)</td>
<td>00:00:01 to 23:59:59</td>
<td>1 sec</td>
<td>2 sec</td>
</tr>
<tr>
<td>Block Time</td>
<td>0.5 to 4.0 (hr)</td>
<td>0.5 hr</td>
<td>2 sec</td>
</tr>
<tr>
<td>Dose Schedule</td>
<td>00:00 to 23:30</td>
<td>30 min</td>
<td>2 min</td>
</tr>
<tr>
<td><strong>Sensing Parameters</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supine Time</td>
<td>1, 5, 30, or 60 (min)</td>
<td>N/A</td>
<td>1 min</td>
</tr>
<tr>
<td>Supine Level</td>
<td>50 to 80 (˚)</td>
<td>10˚</td>
<td>10˚</td>
</tr>
<tr>
<td>Minute %</td>
<td>70, 80, 90, or 95 (%)</td>
<td>N/A</td>
<td>1%</td>
</tr>
<tr>
<td>Supine Time %</td>
<td>70, 80, 90, or 95 (%)</td>
<td>N/A</td>
<td>1%</td>
</tr>
</tbody>
</table>
Appendix 1

EndoStim External Programmer System Operations

Initial Set-up

You will be provided with an IEC60950 certified Tablet PC that has embedded Microsoft® Windows® 8 and the Programmer software already installed. Other features have been locked out to enhance security.

Connecting and Powering the Programmer System

When recharging the Tablet PC, connect the charger to the mains (AC power) per labeling on the charger. It is recommended that you routinely charge the battery of the Tablet PC between uses.

Prior to powering the Tablet PC, connect the USB end of the hand-held Programmer Wand to the USB port of the Tablet PC. The Programmer Wand is powered from the USB port of the Tablet PC (5V, 0.5A).

Note: The Programmer Wand should only be connected to the USB port of the Tablet PC when run on battery power only.

Note: The tablet requires at least 4 hours of charging to be fully charged. Always charge the programmer fully before each use and it is recommended to plug in and charge the tablet soon after each use.

Connecting the Tablet PC to mains is not allowed while the Programmer Wand is connected. Operate the Programmer Wand using only the Tablet PC battery. Use the AC connection only when recharging the Tablet PC, and ensure that the USB cable is disconnected from the Tablet PC while charging.

If the Tablet PC is connected to mains, the Programmer software disables power to all computer USB ports and provides a popup warning (Figure 17). The popup warning message terminates once the Tablet PC is disconnected from the mains and you press “Retry”. The Tablet PC shuts down if you press “Close.”

Launch the Software

Powering On the Tablet PC will launch the Programmer software. The launch screen appears (Figure 18). Swipe upward on the touch screen to enable the password screen (Figure 19).
Enter the password and press “Accept” or press Enter. The password is “EndoStim”.

The Programmer Main Screen appears (Figure 20). The screen is divided into two sections, Information and Programming. These sections are further described below.

1. Information — The top section (above the solid horizontal line) contains icons for retrieving and displaying device information. These are labeled below:
<table>
<thead>
<tr>
<th>ICON</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| ![Interrogate](image1.png) | Interrogate  
Click on this icon to interrogate the IPG. |
| ![Serial Number](image2.png) | Serial Number  
The serial number of the IPG is displayed here. |
| ![Battery Voltage](image3.png) | Battery Voltage  
The battery voltage of the IPG is displayed here. |
| ![Lead Impedance](image4.png) | Lead Impedance  
The lead impedance is displayed here. |

In addition, there is a Log Bar that displays commands and results.

2. Programming — The lower section (below the solid horizontal line) contains icons for programming the device parameters. These are labeled below:

<table>
<thead>
<tr>
<th>ICON</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| ![EndoStim](image5.png) | Default Parameters Button  
Click on the logo to program the IPG to default parameters. |
| ![Stimulation Amplitude and Polarity](image6.png) | Stimulation Amplitude and Polarity  
Click on the top button of this icon to program the stimulation amplitude or to turn off stimulation. Click on the lower icon to switch polarity mode between “regular”, “reversed” and “alternating” (which switches between “regular” and “reversed” polarity periodically.) |
| ![Program](image7.png) | Program  
Click on this icon to program the IPG |
| ![Urgent Programming](image8.png) | Urgent Programming  
Emergency stop. |
| ![Cyclic Mode Stimulation Type](image9.png) | Cyclic Mode Stimulation Type  
“All Day” – Click on this icon to schedule cyclic stimulation sessions all day.  
“Supine Only” – Click on this icon to schedule cyclic stimulation therapy while the patient is sleeping (laying flat without movement). During other times (“awake” times) the stimulation will be delivered according to the schedule programmed in the “awake” stimulation timing. |
| ![Cyclic Mode Stimulation Interval](image10.png) | Cyclic Mode Stimulation Interval  
Click on the number icon to select the stimulation interval for Cyclic Modes All Day and Supine Only. For example, selecting the icon with the ‘2’ sets the stimulation interval to every ‘2 hours’. |

**NOTE:** The Programmer automatically disables certain parameters and icons based upon values of other parameters or states of other icons. For an icon example, the Program icon will not be active unless a parameter was changed. For
a parameter example, the *Stimulation Session Timing – Awake* will not allow for programming two stimulation sessions immediately adjacent to each other.

**Initial Programmer Set-Up**

Once the GUI launches, verify/set Tablet time by selecting the pull-down menu item *Tools → System Time*.

Verify the Tablet PC battery using the Tools menu and selecting Programmer Battery.

Power down the tablet and charge it by connecting the power supply to an outlet (4 hours until full charge)

**Initial IPG Set-Up and Test**

Initiate a Programming Session

To initiate a programming session, place the Programming Wand over the IPG (still in the sterile package). Red and green LED lights indicate level of communication:

- Communication — At least one of the Signal Strength LEDs blinks about once per second.
  - Stronger communication — Green LEDs at the top blink.
  - Weaker communication — Red LEDs at the bottom blink. If this occurs, reposition the Programmer Wand over the IPG box until Green LEDs at the top blink. This should be possible when programming any IPG still in the sterile package.

**NOTE:** The Programmer can communicate with the IPG at a maximum distance of 5.0 cm.

**IPG Set-Up**

**NOTE:** The wand needs to be in good communication with the IPG during the entire programming session duration. The error message “Interrogation Error: Error executing Interrogation, Retry” will notify you when the communication quality does not allow you to continue with the session, in which case re-position the wand until good communication is re-established.

Click on the “Interrogate” icon ‣ at the far left of the Information section (Figure 21).

The statistics screen is first opened and will be empty for a new device. Click *Close* to continue.

![Figure 21 EndoStim IPG Set Up](image)
The Time Setting pop-up will then appear (see Figure 22 below):

1. Select **Set With PC Time**.
2. Select **Close**.

**Note:** Always ensure that the time of day is the same between the IPG and the Programmer. If the time, or clock, is not synchronized, the patient may receive therapy that is off-schedule.

![Figure 22 Time Setting Pop-Up Screen](image)

Set Time:

1. Click:
2. Click:

![Figure 23 Information on the Main Screen following first interrogation](image)

The remaining parameters should then be filled in by the user.

– Visit type should be set to “Pre-implant” (See Figure 24 below.)
Pressing the “EndoStim” icon at the top of the scheduling bars will enable the default stimulation timing which is 30 minute sessions applied every 2 hours (i.e. 30 minutes on, 90 minute off).

Verify Information

Battery voltage for a new IPG should be at least 2.78V, amplitude should be “OFF” and polarity set to “Normal”. Lead impedance should be “out of range” since the device is not connected to the lead in the package.

1. Verify the IPG serial number shown on the screen matches the serial number shown on the corresponding IPG package.
2. Verify the battery voltage is at least 2.78V.
3. Verify the Amplitude is set to Off.
4. Verify Polarity is set to Normal.

**Day of Surgery Preparation**

**Table Set-Up**

Arrange Tablet PC and programmer wand on a small wheeled table in the operating room. Verify the Tablet PC is running on battery power only. Connect the Programmer Wand.

![Figure 27 Day of Surgery Preparation](image1)

**IPG Verification**

Place the Programmer Wand over the IPG (still in the sterile package) (Figure 27). Click on the “Interrogate” icon at the far left of the Information section (Figure 28).

![Figure 28 Day of Surgery – IPG Verification](image2)
1. Manage the statistics and time dialog windows as described above.
2. Verify the IPG serial number shown on the screen matches the serial number shown on the corresponding IPG package.
3. Verify the battery voltage is at least 2.78V.
4. Verify the Amplitude is set to Off.
5. Verify Polarity is set to Normal.

Set Visit Type as “Implant” and Enter Patient Information (Figure 29).

![Figure 29 Visit Type and Patient Information Screens]

Measure Lead Impedance (IPG out of pocket)

Once the lead connector is plugged into the IPG, but the IPG is still out of the pocket, interrogate the IPG and check lead impedance.

1. Place the Programmer Wand in a sterile sleeve and then bring the Programmer Wand into the sterile field (Figure 30). Keep the Programmer Wand in the sterile field, if necessary, by temporarily disconnecting it from the Tablet PC.
2. Verify that there are blinking LEDs on the Programmer Wand to ensure effective communication. The distance between the Programmer Wand and IPG should be 2 cm to 5 cm.

3. Measure Lead Impedance 3 times (Click Interrogate icon) (Figure 31).

4. Verify that the Impedance is 100–600 Ohms (variation in impedance of +/-10% among measurements is acceptable). In rare cases, if the impedance is too high or too low, the text Out of Range appears in the icon.

5. If Impedance is out of range:
   a. Disconnect lead connector, clean with sterile saline. Re-insert and re-secure with screws into IPG header, ensuring connector tip is visible in header. Measure Impedance.
   b. If still out of range, perform Device Reset (Tools → Reset IPG) (Figure 31). Measure Impedance again.
   c. If still out of range, repeat steps a and b.
   d. If still out of range, replace IPG.
If still out of range, disconnect lead connector, clean and re-insert. Measure Impedance again.

If still out of range, replace the lead.

Measure Lead Impedance (IPG in pocket)

Once the lead connector is plugged into the IPG and the IPG has been placed in the pocket, but before the pocket is closed, interrogate the IPG and check lead impedance. Repeat steps in section Measure Lead Impedance (IPG out of pocket).

Initial IPG Parameter Setting

Preparation

1. Connect the Programmer Wand to a fully-charged Tablet PC running on battery power only.
2. Place the Programmer Wand over the implanted IPG site (over patient’s shirt or gown).
3. Make sure the green LED lights are blinking at the top of the LED line. The Programmer Wand should be stable in this position during the entire process.

Interrogate IPG

1. Click on the “Interrogate” icon at the far left of the Information section (Figure 33). The remaining 3 icons in the Information section of the Programmer screen should be filled in with appropriate values as shown in Figure 35.
2. Verify the battery voltage is at least 2.78V.
3. Verify the Amplitude is set to Off.
4. Verify Polarity is set to Normal.
5. Verify that the Impedance is 100-600 Ohms (variation in impedance of +/-10% among measurements is acceptable).

Set Stimulation Settings

Program default stimulation settings by clicking on the EndoStim logo. Click the Program icon. Default stimulation therapy is delivered 12x per day (every 2 hours), at 5.0mA and normal polarity.
Baseline ECG Monitoring
Complete baseline ECG monitoring of the patient per the section on Post-Operative Care.

**Standard Patient Follow-up Visit**

**Preparation**
1. Connect the Programmer Wand to a fully-charged Tablet PC that is running on battery power only.
2. Place the Programmer Wand over the implanted IPG site (over patient’s shirt or gown).
3. Make sure the green LED lights are blinking at the top of the LED line. The Programmer Wand should be stable in this position during the entire process.

**Interrogate IPG**
1. Click on the “Interrogate” icon at the far left of the Information section.
2. On the statistics screen (Figure 37), verify that all stimulations were delivered as programmed. If there are any Impedance Out of Range events, consider an X-ray or fluoroscopy to assess lead impedance. Document any Magnet Deactivation events and discuss potential magnet exposure events with the patient. If any Voltage Limits occurred, adjust the Impedance Tracker Settings by accepting the recommended values after performing a lead impedance measurement. Click “Close” on the statistics screen.

![Figure 35 IPG Interrogations – Statistics Window](image)

**Verify IPG Time**
1. When the Time dialog window opens (Figure 36), click *Set with PC*.
2. Click *Close*.

![Figure 36 EndoStim Programmer Time Window](image)
3. The remaining 3 icons in the Information section of the Programmer screen should be filled in with appropriate values as shown in Figure 37. Ensure the serial number on the screen matches the patient’s IPG serial number.

![Figure 37 Verify IPG Information](image)

4. Verify the battery voltage is at least 2.78V.
5. Verify lead impedance is 100 – 800 Ohms.
6. Verify the Amplitude is set to 5mA.
7. Verify Polarity is set to Normal.
8. Verify that there is an ‘X’ in the boxes corresponding to 08:00, 10:00, …, 18:00, 20:00, …, 04:00, 06:00 in the vertical time of day bars in the center of the screen.

Parameter Optimization

If the patient’s condition is not satisfactory, change Polarity from “Normal” to “Inverted” (Figure 38). Apply changes by clicking blinking ‘Program’ button.

If Polarity was inverted and the patient’s condition is still not satisfactory, change Polarity from “Inverted” to “Alternating” (Figure 39). Apply changes by clicking blinking ‘Program’ button. So that the number of sessions delivered for each electrode is not significantly decreased, we also recommend increasing the number of sessions per day to 16 or 24 (Figure 40). Apply changes by clicking blinking ‘Program’ button.

If after changing to “Alternating” polarity and increasing the number of sessions per day, the patient’s condition is still not satisfactory, increase the pulse amplitude (Figure 41).

Patients may be optimized to a maximum allowed amplitude of 10 mA and a maximum of 24 sessions per day (12 sessions per electrode per day). Please note that increasing the number of sessions and/or the pulse amplitude will decrease the expected battery life.
Figure 38 Parameter Optimization: Inverted Polarity

Figure 39 Parameter Optimization: Alternating Polarity
Backup Log File
Back up the log file and copy it to an external memory device.

Generate Patient Report
Patient data can be edited using the pull-down menu Tools→Enter Patient Data. The report can be reviewed using the pull-down menu Tools→View Patient Report. To save patient report data, disconnect the Programmer Wand and connect an external USB memory drive (provided by EndoStim). Select Tools → Save Patient Report. The file can then be transported to another computer for archiving and printing.
Other Operations

Termin ate Stimulation

To stop stimulation, program the amplitude to OFF on the amplitude icon , and then select the Program button .

You can also use the Urgent Programming icon to stop stimulation at any time.

Reset the IPG

To reset the IPG, select the pull-down menu, Tools→Reset IPG.

Shut Down the Programmer

To turn off the Programmer:

1. Click on the X at the top right of the screen OR select the pull-down menu File→Exit.
2. Disconnect the Programmer Wand from the computer.
3. Turn the computer off.

Upgrade Features

Upgrade features included under the “Upgrade” tab include Usage Tracking, Increased Patient Support, and IPG Firmware Upgrade capabilities. These features are not available to investigators in the IDE Study.

Environment of Use and Operator Profile

The operators of the Programmer include physicians in charge of either implanting or monitoring an IPG, and trained medical personnel who assist physicians. Operators will be familiar with operation of electronic medical equipment, particularly IPGs and programmers. The operators will have been trained on the operation of the EndoStim Programmer.
The Programmer is used in an operating room where the IPG is being implanted. When in the operating room, the Programmer should be brought into the sterile field through a sterile sleeve while the Tablet PC remains outside the sterile field. The surgeon should place the Programmer over the IPG while an appropriate person outside the sterile field operates the Programmer.

The Programmer is also used in a clinical room where patients with an implanted IPG are monitored. When in the clinic, the clinician should place the Programmer over the IPG and have either an assistant or the patient hold the Programmer in place. The patient can sit or lie down. The Tablet PC should be outside the patient environment, at least 1.5 meters away, and operated by the clinician.

To be compliant with electromagnetic compatibility requirements (interference characteristics), the Programmer should not be used adjacent to or stacked with other equipment. If adjacent or stacked use is necessary, verify that the Programmer functions properly. It is recommended to have an additional Programmer present at each implant and clinic visit.

**Maintenance**

After each use, it is recommended that you disconnect the Programmer Wand from the USB port of the Tablet PC. To clean the Programmer, use a soft cloth dampened with distilled water, methanol, or isopropyl alcohol to wipe the exterior case of the Programming Wand. Do not use solvents or cleaning cloths infused with chemical cleaning agents.

The Programmer Wand does not contain any user serviceable parts. If any Programmer Wand parts become damaged or loose, or it does not function properly, return the Programmer Wand to EndoStim.

**Handling and Storage**

Do not use the Programmer if the package is damaged or if the Programmer has been dropped from a height of 1 meter or more. Return damaged packages to EndoStim. Table 10 lists Programmer environmental conditions.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Shipping</th>
<th>Operating and Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>-20-70 °C (-4-158 °F)</td>
<td>5-37 °C (41-104 °F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>15-93 % non-condensing</td>
<td>15-93 % non-condensing</td>
</tr>
<tr>
<td>Atmospheric Pressure</td>
<td>54.0-101.3 kPa (7.8-14.7 psi)</td>
<td>54.0-101.3 kPa (7.8-14.7 psi)</td>
</tr>
<tr>
<td>Altitude</td>
<td>0-5000 m (0-16,404 ft)</td>
<td>0-5000 m (0-16,404 ft)</td>
</tr>
</tbody>
</table>

**Precautions**

Avoid contact between the patient’s skin and the Programmer Wand whenever possible.

The Programmer is not protected against the ingress of water (IXP0). Avoid immersing the Programmer in any fluids.

Do not use the Programmer in the presence of flammable anesthetics.

Do not sterilize the Programmer.

Do not connect any other equipment to the Programmer.

Do not modify the Programmer in any way.

**Service Life and Disposal**

The life of service is expected to be 5 years. The Programmer should be returned to EndoStim when disposal is required.